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Introduction

Today’s Demands Mean New Opportunities
� Web sites with multimedia content are fast becoming the new standard in today’s Internet.  Video on the net 
is no longer solely the domain of Hollywood movie trailers.  In fact, businesses all over the world in every industry 
are now seizing upon the multitude of opportunities that Internet video streaming has to offer.              

The Challenges

 Placing video on your web site requires an investment of time, man power and money.  Minimizing this 
investment is an essential part of making streaming video profitable for your company.   But let the buyer beware!!  
Streaming video presents many obstacles and challenges.  Here are just a few:

• Streaming video is bandwidth intensive -  If you are going to be doing a heavy amount of video stream-
ing this recurring cost can really eat into your margins.  In addition some technologies are so bandwidth 
intensive that a quality experience is unavailable to the dial-up user.  This factor alone can reduce your 
audience by half.     

• Video server technologies are built upon proprietary platforms -  Depending on the technology this may 
require you to purchase expensive annualized software licenses.  In addition because this technology is 
not standardized it also becomes necessary to offer multiple file formats in order to guarantee compatibil-
ity with your audience.  

• Web surfers have a wide array of bandwidth connection speeds - to offer each client the highest quality 
experience for their connection type you must create multiple versions of each video file.  This adds to the 
amount of time required to create your content and also complicates deployment.  

• Security - Video streaming technologies often make use of vulnerable protocols such as UDP1.  This not 
only increases your network’s security exposure but may also prevent you from streaming to clients who 
are behind restrictive firewalls.  

• Video players need constant upgrading - Updating, upgrading and patching media players is just too 
much work to expect from your clients.  A major upgrade can take several hours depending on the client’s 
Internet connection speed.  As a result you cannot take advantage of new technology in order to guaran-
tee backward compatibility with your customer base. 


 As a result of all these challenges the overhead cost associated with creating and maintaining a streaming 
video network has kept many businesses from utilizing this amazing advancement in technology.

The Solution 
� VX30 is the answer.  With no other solution on the market today will you be able to as cost effectively deploy 
streaming video content onto your website.  This powerful encoding application will allow you to easily and quickly 
convert digital video files in practically any format into a VX30 Simple Streaming package.  This package is a totally 
self contained streaming video resource that can support users from  dial-up to broadband, only uses HTTP for 
transport and does not require a video server to be streamed nor a media player for decoding on the client’s com-
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1 User Datagram Protocol) - Transport layer protocol in the TCP/IP protocol suite used in the Internet. UDP is used at 
the two ends of a data transfer. It does not establish a connection or provide reliable data transfer like TCP.



puter.  However VX30 is not just for the content provider, clients will also be amazed with the immediate video play-
back and the stunning quality of your VX30 videos.  
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Installation

System Requirements

 Before installing your VX30 Encoder please make sure that your workstation meets the following require-
ments.

1. A Windows PC running Windows 2000 or Windows XP.

2. A Pentium IV 1.8GHZ or equivalent (2.4GHZ recommended).

3. 256 RAM (512MB recommended)

Install Shield

 To begin installation of your VX30 Encoder, simply decompress the zip file you downloaded from the MXS 
website and navigate to the Encoder_Software folder.  Double click the setup.exe file to launch the installation wiz-
ard.


 Please follow the on screen instructions to complete the installation process.  Besides installing the VX30 
Encoder application the install shield will also install a driver bundle that will allow your application to interface 
with nearly any digital file format and hardware device2. 

Activation

 The first time you use your VX30 Encoder application you will be prompted to enter your name, company 
name and the license string provided to you by MXS inc.  Please make sure that you enter this information exactly as 
it appears in your License Information email from MXS inc.  

Activation Screen
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2 The Encoder interfaces with all hardware devices that support the Video for Windows Driver. 



If you cannot activate your encoder please contact your MXS Sales Agent.  After successfully entering your license 
information you will be redirected to the Encoder’s Workspace Area.

M a u i  X - S t r e a m  I n c .� V X 3 0  E n c o d e r  U s e r  M a n u a l

4



The Workspace Area

The General Layout
� The Encoding Station’s workspace is divided into four subsections.  These subsections can be resized manu-
ally and by default will automatically resize whenever the mouse rolls over a different subsection.  To resize the 
workspace drag on any of the frame bars that forms a “T” at the center of the workspace area.  To turn the auto resiz-
ing feature off go to File -> Auto resizing from the Windows Tool Bar.  To make a subsection full screen press the rec-
tangular button at the top right hand corner of each area. 

The Workspace Area

The Four Corners


 The four subsections of the workspace area are from left to right, top to bottom are the File/Device Input 
area, the Encoding Parameters section, the Preview Player and the Encoding Progress Indicator.  The VX30 Encoder 
comes with many tools for producing your streaming video clip(s).  In the input area you can set up batch processing, 
in the encoding parameters section you can do some simple video editing as well as create the run time characteris-
tics of your Player applet.  From the preview section you can watch the original clip as well as create snap shots for 
later use.  All these features will be explained in full detail later in this chapter.

Adding Source Files
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 The input section (the area in the upper left-hand corner) is where you place your source files that you wish 
to encode.  There are several ways to add files into the input section which should all be familiar to users who are 
experienced with the Windows Operating System.  For those new to Windows the easiest way is to click the yellow 
folder in the tool bar at the top of the input section and choose Add File(s).  This will launch the windows explorer 
dialog box.  Navigate to your files location and than add the appropriate files.

Add Files
 

� The input section will display the Source File’s Name and Path to its location on the local drive.  Removing a 
file is as simple as highlighting it and pressing the black X in the toolbar.  To remove all files in the input section you 
can click the red X in the same toolbar.  You can learn more about a source file by highlighting it and than pressing the 
Yellow Question Mark that appears in the toolbar.  A dialog box will appear that contains detailed information on the 
source video file.

Batch Processing


 The VX30 Encoder supports batch processing.  This can be a convenient feature if you have a number of 
videos that you wish to encode.  To batch process continue to add as many files as you need into the Input Section.  If 
you have multiple files that need to have the same encoding parameters first edit one file to have the desired charac-
teristics.  To give another file the same attributes highlight the properly configured file and than press the shift key on 
the keyboard and the arrow key (up or down) to highlight both files.  This will give the second file the same settings 
as the first.  You can continue to press the arrow key to include as many files as you require.
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Source Information Dialog Box

Previewing Source Files

 The preview section is in the lower left hand side of the workspace area.  The preview section is where you 
can watch your source video files.  To view a source file highlight it inside the Input Section and than press Preview 
-> Play/Pause from the Windows Toolbar.
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Viewing A Source File

� From the player’s control bar you have all the standard options for video playback i.e. play, pause, stop etc... 
From the toolbar you can also take snapshots of the video.  These snapshots can be used later on as the title, back-
ground or end images of your video.  To create a snapshot press the camera icon in the Player Toolbar.  After pressing 
the camera icon you will be prompted by Windows Explorer for the location of where you would like to save the file.
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The Preview Section

Adding DVD as a Source


 The first step in encoding a DVD is to place an unencrypted DVD into your DVD drive.  Then choose File -> 
add DVD from the Windows Tool Bar.  You are now ready to go to the Parameters section to input your 
configuration.3
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3 Currently this is not supported.  As a workaround you can copy the VOB files from your DVD onto the local hard 
drive.  After the files have finished being transfered rename the file extensions to .mpg or .mpeg.  These files can now 
be placed into the Encoder by choose “add File”.



Add a DVD

Adding a Capture Device as Source

� If you have a Windows approved video hardware device (i.e. a web camera, a video capture card, camcorder 
etc...) you will be able to capture a live stream from the device directly into VX30 format.  The first step in encoding 
from a device is to make sure that you have properly installed the hardware per the manufacturer’s instructions with 
your PC.  After you have successfully installed the device you can initiate it with your VX30 Encoder application by 
choosing File -> add Device from the Windows Toolbar.  After choosing to add a device a dialog box will appear with 
the input devices that were discovered on your system.
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Add Device


 Choose the appropriate device from the drop down boxes provided for both the audio and video devices.  
After initializing your device you should test the device, by pressing Play from the Windows Toolbar.  After you have 
verified that the device is playing properly you can move on to the parameters section.
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Preview Device




 Capturing from device is slightly different than standard encoding.  The difference being for capturing you 
will need to set a length for the amount of time that you wish to encode.  Under the Experts tab in the Encoding Pa-
rameters section you will need to enter an integer value that represents the number of seconds that you need to cap-
ture.  In the subsection Time Range Selection (seconds) set the End value to be the length of time that you need to 
encode.  Another important difference from live capture and standard encoding is that with live capture you can only 
record for one profile setting.  When setting up your parameters in the Expert section make sure that you have re-
moved all the profiles except the one you wish to encode.     
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Set Length of Video

Encoding Settings

 The Encoding Parameters section is where you input the configurations for the VX30 movies that will be 
created by the encoder.  The VX30 movies are highly configurable and you have many options on the size, quality, 
presentation and characteristics of your video clips.  At first you may wish to keep the production of your clips sim-
ple but as you grow in familiarity with the program we invite you to try the more advanced features.  You will be 
glad that you did!


 The Encoding Parameters section comes in three sub-sections that are navigated by the three tabs at the top 
of the section named Simple, Expert and Applet.  We will describe each section in full detail but generally they are 
associated this way.

1. Simple - This is for the true beginner.  By only using this section you can create a complete VX30 Movie. 
 However for best results we recommend that you also learn to use the Experts sections.  This section 
does include a few options that are important to every level of experience which will be outlined later.

2. Expert - This section is where you can completely control the physical properties of your movie.  This 
section is absolutely essential for professional results.  We strongly recommend that you have a close 
look at this section before you place video onto your server.  Do not be apprehensive this section is not 
that complicated and once you understand it’s purpose it will make creating professional results easy.

3. Applet - This section has a number of parameters that control the characteristics of the player applet.  
This section includes many options that you may wish to explore and will be essential for the Profes-
sional who wishes to make their applet a natural part of their web site.
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Make it Simple

The Simple Section


 The Destination Folder is where your VX30 files will be placed as they are created.  We recommend that you 
create separate folders for each batch of videos that you create.  While not completely necessary we have found that 
this is the best way to organize your video clips.  You can select the Destination Folder by pressing the button to the 
right of the input box.  This will open up your Windows Explorer - navigate to the desired output location and press 
OK.


 The VX30 Encoder comes with a built in FTP client.  Should you desire to place your videos directly onto 
your server you can configure your FTP client to do this automatically.  To set up your FTP client click the button to 
the right of the input box.  This will open up a new window where you can input your FTP information.
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FTP Client


 The ftp client has most of the standard capabilities found in FTP i.e. connect/disconnect, create folder, re-
fresh file list and delete files.  All these actions can be performed from the tool bar located just above the directory 
input box.   After entering your hostname, username and password create a connection by pressing by the button on 
the left hand side of the toolbar.  After the client has made connection to the server you will be able to navigate to the 
location of your desired output.  Press OK to exit the window.

  The Simple Slider and The Quality Bar

� These two tools are designed for the novice who wants to quickly create a streaming video.  The “speedome-
ter” looking apparatus on the left side is the Simple Slider.  The Simple Slider determines what kind of files will be 
created.  The VX30 Encoder creates different sizes of video files depending on how much bandwidth is going to be 
used per second to render the video on the client’s computer.  The Simple Slider will allow you to create thresholds of 
what will be the available range of connection types.  In the example given above the smallest file created will be for 
users on a 48kbps4 connection.  Conversely the largest file created will be for a 448 kbps connection.  The larger the 
range you create the more VX30 files will be created.  This can take up unwanted disk space and the heights and 
widths created may not fit your exact needs so we recommend that you use the slider bar only for training purposes.
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� The Quality Bar is the object to the right of the Simple Slider.  The higher the setting the better color compo-
sition your video files will have.  The trade off is that better quality requires more memory on the client’s computer.  
Because the trade off is minimal we recommend that you always set the Quality Bar to the highest level.

Images and the Applet


 The VX30 player applet can make use of three types of images.  These images are title, end and background.  
Please find a quick description of each below.

• Title Image - The value of this setting is an image file that will appear before the video starts to play.  This 
can be useful for corporate branding or adding useful static information to the beginning of your video 
clip.

• End Image  -  The value of this setting is an image file that will appear at the end of the video clip.

• Background Image - The VX30 Video Stream can come in different sizes depending on the settings used 
to create it and the client’s potential bandwidth.  For example you may have designed your settings so 
that the size of the movie will be larger when it is played for a client with a high-speed connection than 
when it is played for a client on a dial up connection.  However even though the video becomes smaller 
the applet stays the same size.  This can be unsightly if the video is embedded into a larger graphic be-
cause a border will appear in the space between the edge of the video and the edge of the applet.  This 
problem can be solved with the use of a background image.  When the border begins to show you will see 
the background image instead of the background color of the applet.  If you make the background image 
part of the graphic you will give the illusion that the applet is always the same size as the video.


 Image files can be any of the standard formats i.e. jpeg, gif, bmp etc...  When the video is finished encoding 
all the selected image files will be included in the destination folder with your VX30 files.  Selecting the image to be 
used for each of the above values is done by clicking the button to the right of the corresponding input box.  Navigate 
to the files location on your local or network drive and press O.K.

Expert Settings 
� The Experts Section is where you can specify the exact physical dimensions of your VX30 video clips.  In the 
main table section you can specify how many Profiles you are going to create.  Each row constitutes one profile, 
which you should think of as it’s own separate video clip.  You create as many of these Profiles as you would like to 
make available for your customers.  Typically for streaming video on the Internet you will need to create three types 
of profiles which can be characterized as small, medium and large.  Each of these profiles will have its own audio and 
video file.  The VX Player Applet determines which of these Profiles to make available to the customer depending on 
the speed of their Internet connection.  For example if someone is on a dial-up connection they would receive the 
small Profile.
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The Experts Section
 


 From within the Experts Table you can add, edit or delete profiles.  There are three buttons at the bottom of 
the table for major actions.  To edit a column in a profile use the mouse to click on the column and than add in the 
new value using your keyboard.  Once you have highlighted a column within the table you can navigate it using 
your arrow keys.  Below you will find a table for the recommended settings for creating video clips for the web.  You 
can create your own settings based upon your needs and experience but this is an excellent starting point and will 
produce the same high quality clips that you see on the www.mxsinc.com website.  Please note that the widths and 
heights given in the example are for videos that come in the standard NTSC 4 x 3 format.  If your video comes in a 
different format i.e. wide screen, you will need to adjust your width to height ratio accordingly.

Recommended Settings 

WIDTH HEIGHT FRAME RATE BPS VIDEO BPS AUDIO

240 180 10 40 8

320 240 13 112 16

320 240 15 268 32


 Note that you can add more profiles or adjust any of these settings to your own requirements.  However 
these settings are an excellent starting ground for professional results.  They cover a variety of bandwidth potentials, 
they will not take up an inordinate amount of hard drive space and the physical size/frame rates will guarantee that 
the video will play on older slower computers.  

Additional Settings


 To the right of the table area are some additional settings.  These settings have some basic editing tools that 
can be used if you need to make some simple changes to your video.  A quick description of each section is provided 
below:
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• Deinterlace - Commonly when video is prepared for television it is interlaced.  This is the process by 
which “alternate raster lines of a frame are displaced vertically by half the scan line pitch and displaced 
temporarily by half the frame time, to form an odd and  an even field.5”  When displayed on a computer 
screen interlace can make the video look like it is segmented horizontally.  To solve this problem choose 
the deinterlace option when encoding.

• Save All Images - If you choose this option every frame that is encoded will be saved as a jpeg or bmp 
image.  This can be useful if you need to analyze every frame of motion i.e. sports training.

• Save Sound - If you choose this option the sound will be saved as an audio track.6

• Time Range - If you wish to encode only a portion of the original file you can use this section to set be-
ginning and end points.  The points are set in seconds.  So for example if you wish to only encode the first 
15 seconds of a clip you would set Begin to 0 and you would set End to 15. 

• Video Margins - if your clip has unwanted margins you can set these crop marks to remove them.  The 
measurement is done in pixels.  Typically if your video suffers from “over-scan” you will need to set all 
your margins to 16.

• Audio Volume - this slider bar will adjust the volume of your audio track.  

Applet Settings
� The video is rendered on the client’s computer by a small program called an applet.  An applet is a small 
highly secure program that uses the Java programming language to operate.  Applets are fully integrated into the 
HTML standard and they can be seamlessly integrated into your website.  Applets are highly customizable and from 
within the encoding application you can easily set all your applet’s settings.  These settings can be found under the 
third tab in the Parameters Section called Applet.  Each of the Applet Settings are described below:

•  Base URL - This comes in two forms Documentbase or Codebase.  You use the Documentbase if the web 
page and the video files reside in the same folder on the server.  If the web page is going to link to a video 
that exists in a different folder or server entirely you need to use the Codebase parameter.

• OnClick URL - This value when left blank has no effect on the applet.  However if you place a web ad-
dress as the value, when a user clicks on the video it will redirect them to the value specified.

• OnClick URL target window - This value when used in conjuction with OnClick URL determines which 
web window will be used to load the URL.  This uses the HTML standard code for determining which 
window will be opened.

• _blank = new window

• _parent = parent window

• _self = this window
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• Enable auto playback - this determines when the video will start playing.  If set to true the video will 
start playing as soon as it has buffered.  If you set it to false the video will start playing when the play 
button has been pressed.  The final option is to set it to Rollover, which sets the video to start when the 
mouse rolls over the video.

• Loop playback - if this is set to true the video will restart playing when it reaches the end.  If set to false 
the video will only play once.

• Rewind when done playing - this value is used in conjunction with the title and end images that you 
specified in the Simple Section.  When set to true when the video end it will load the title image.  If set to 
false it will load the End image when done playing.

• Mute Audio - determines whether to turn the sound on or off.

• Applet’s background color - By default the applet’s background color is white.  However you can adjust 
this to another color by clicking on the value box.  This will load a color chart in a new window.  Choose 
your desired setting and press OK.

• Video alpha value, 0..255 - This will set the transparency level of the video with 0 being fully transparent 
and 255 being opaque.7

• Disable zoom button - When the mouse rolls over the video an image of a square in a square appears in 
the bottom right hand corner of the video.  This image is a link that will open the video in its own resiz-
able window.  If you want to disable this zoom button set this value to true.  

• Use ascetic popup - When a user right (pc)/ctrl (mac) clicks the player applet a dialog box will appear.  If 
you want the dialog box to contain a full properties window you set this value to false.  However if you 
want the window to only have a link to VX30 appear set this value to true.

• Display status messages - When set to true all buffering and loading messages will be printed to screen at 
the bottom of the applet.  This can be very useful information for the client and we recommend that you 
set this value to true.  However if you prefer you can turn off the status messages by setting this value to 
false.

• Status messages color - This value controls what color the status messages will be.  We recommend that 
you use a color that will be visible against the background color you chose for the applet’s background 
color.

• Enable control panel - You can turn on/off the control panel of the applet with this setting.  The control 
panel is the bar that contains the play/pause, stop and mute buttons.

• Controls layout string - This setting can be broken down to two parts separated by a colon.  The first two 
letters determine where the control panel will appear on the applet.  Use the chart below to position your 
buttons.
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Horizontal Alignment

LEFT CENTER RIGHT

TOP tl tc tr

BOTTOM bl bc br

   

      Vertical Alignment

TOP CENTER BOTTOM

LEFT lt lc lb

RIGHT rt rc rb


 The letters that appear after the colon determine which buttons will appear and in which order.  You have 
four options with button on the horizontal control bar and three options with the vertical control bar.  Your options 
are as follows

• p - play/pause

• s - stop

• m - mute

• b - timeline indicator8 


 The default setting for the Controls layout string is bc:psbm which would put the controls at the bottom 
center with the layout being: play/pause - stop - timeline indicator - mute.

• Static Control Panel - If set to true the control panel will always appear in the location specified by Con-
trols layout string.  If set to false the control panel will hide until the mouse rolls over the video.

• Panel show delay, ms - If static control panel is set to true this value (in milliseconds) will control how 
long the panel will be visible once the mouse has moved away from the video.  After the delay has ex-
pired the control panel will disappear.

Encoding Video

 Now that you have set up your profiles and applet settings encoding the video is just a click away.  In the 
Encoding Area simply click the Encode button to start the process.  After you have started the encoding the Encoding 
Area will go full screen and will show the progress of your job.  The progress is stated in two color progress bars that 
appear at the top of the window.  The top bar shows the progress on the current profile that is being created while the 
bar beneath shows the progress for the total job.  Beneath the lower bar is an indicator on the amount of time the job 
has been encoding for and estimated length of the entire job.  You can control the processing priority of your job from 
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the select box.  You may also choose to watch the source file as it is being encoded by checking the corresponding 
box.   At any time you can pause or stop the job by using the corresponding buttons at the bottom of the window. 

� If you are using the ftp function as soon as the first file has completed encoding the application will connect 
to the server and begin to transfer the files.  This will continue until all the files have been uploaded.  When the job 
has been completed the Encoding Area will minimize back to the lower right hand corner. 
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The Video Package

Output Files

 To see what kind of files the VX30 Encoder creates lets go to one of your Destination folders.  The VX30 En-
coder creates several types of files a brief description of each is given below.

• vxmPlayer.jar - this file contains all the code that is required to render the video on the client’s computer.  
You can consider it a video server in a file.  You will require only one vxmPlayer.jar file per directory.

• xxxx.meta.vx30 - this file acts as a table of contents for the video package.  The jar file reads this file to de-
termine what kind of audio and video files are available for streaming.  There exists exactly one meta file 
per VX30 video.  This file cannot be altered.

• xxxx.audio.vx30 - this is a vx30 audio file.  There may be multiple audio files - depending on the settings 
you used for encoding the video.

• xxxx.video.vx30 - this is a video file.  There may be multiple video files - depending on the settings you 
used for encoding the video.

• xxxx.html - this is an auto-generated web page.  You can preview your VX30 video by opening this file 
with your web browser.  You can link to this file from your web page(s) or you can copy and paste the 
applet code contained within into your web page.

• buttons.gif - this is the default control panel that is used with the encoder.

Sample FIles
� You cannot alter the meta.vx30 file nor can you remove a video or audio file from the package.  For the 
package to operate correctly it must remain intact the way it was created.  However you may edit your HTML file.  
By editing the parameters within you can change the characteristics of the applet.  If a patch is released on the en-
coder you may replace the jar file with a newer one as long as it is not part of a major version upgrade.
  

M a u i  X - S t r e a m  I n c .� V X 3 0  E n c o d e r  U s e r  M a n u a l

22



Placing Video in your Web Page

Preparing the Server
Windows - To stream video from your IIS server you will first need to configure the server to recognize 
VX30 as an accepted mime type.  To configure mime types on your IIS server you need to open your Web 
Sites Properties.  To open Web Site Properties first open the Internet Services Manager which can be found in 
Start -> Administrative Tools -> Internet Information Services (IIS) Manager.  In Internet Services Manager, 
in the console tree, expand SERVERNAME (your local computer), and then expand Web Sites.  In the con-
sole tree, right-click Default Web Site, and then click Properties.  When the Web Site Properties box open 
click on the tab HTTP Headers.  Click the File Types... button in the MIME Map section.  When prompted 
please enter the following values in the appropriate fields.

1. Extension = .vx30

2. Mime-Type = vx30

Unix, Linux, OS X -  Unix based servers do not require any configuration or installation of additional soft-
ware.  

Linking to a VX30 HTML File

 The first step in placing your video on your website is to place the VX30 Video Package onto your web 
server.  If you used the FTP client included with the Encoder your video files are already on your server.  Otherwise 
use your favorite FTP/SFTP client to transfer the files to your web server.  Once the files are on the server you can 
place a link in your web page to the HTML file created by the encoder.

Placing a VX30 Video Into Web Page

 If you prefer you can place the video in your own web page.  This is done by doing two things:

1.  Place the applet Code into your web page.

2. Configure your applet Code to know the location of your VX30.


 You can find the applet code within the HTML file created by the encoder.  Simply open the HTML file with 
your favorite text editor (i.e. notepad, Front Page etc...) and locate the line that contains the opening <applet> tag.  
Than scroll dow the page until you find the closing </applet> tag.  Than copy all the lines contained within including 
the applet tags (the green text shown below).

Sample Code

<!DOCTYPE html PUBLIC “-//W3C//DTD HTML 4.01 Transitionał/EN”>

<html>

<head>
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<meta http-equiv=”Content-Type” content=”text/html; charset=Windows-1252”>

<title></title>

</head>

<body>
<applet name=”vxmPlayer” archive=”vxmPlayer.jar” code=”vxmPlayer.class” width=”256” height=”192” 
mayscript>

<param name=”MetaURL” value=”VX30_NAB_FINAL.meta.vx30”>

<param name=”VideoTitle” value=”VX30_NAB_FINAL”>

<param name=”UrlBase” value=”codebase”>

<param name=”OnClickUrl” value=””>

<param name=”OnClickUrlTarget” value=”_blank”>

<param name=”VideoTitleImageURL” value=”ab70229.jpg”>

<param name=”AutoPlay” value=”true”>

<param name=”RepeatForever” value=”false”>

<param name=”RewindWhenDonePlaying” value=”true”>

<param name=”MuteAudio” value=”false”>

<param name=”BackgroundColor” value=”000000”>

<param name=”VideoAlphaValue” value=”255”>

<param name=”DisableZoomButton” value=”false”>

<param name=”AsceticPopup” value=”false”>

<param name=”ShowStatusMessages” value=”true”>

<param name=”StatusMessagesColor” value=”00FF00”>

<param name=”EnablePanel” value=”false”>

<param name=”PanelImagesURL” value=”buttons.gif”>

<param name=”PanelButtonsWidths” value=”15,15,15,7,6,1,6,15”>

<param name=”ControlsLayout” value=”bc:psbm”>

<param name=”PanelAlwaysOn” value=”true”>

<param name=”PanelShowDelay” value=”3000”>

If you are not seeing graphics and video, your email reader or web browser is not equipped to show Java 
rich media. Please visit

www.java.com !

</applet><br>

<br>
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</body>

</html>


 After you copy the code the next step is to paste it into your web page where you would like the video to 
appear.  However, this code will not properly function until you configure the applet to know where your VX30 
video package is found.  To do this first alter the URLBase parameter, found within the applet tags, to equal Code-
base.  The final step in setting up your VX30 movie is to add a parameter inside the first applet tag called codebase.  
The value of the codebase parameter should equal the location of your VX30 video package.  Please see the sample 
given below.

<applet name=”vxmPlayer” codebase=”http://www.mydomain.com/pathtovideo” archive=”vxmPlayer.jar” 
code=”vxmPlayer.class” width=”256” height=”192” mayscript>


 Test your video by opening the web page.  If instead of the video you see an error 
java.lang.ClassNotFoundException: vxmPlayer.class -  than you have not properly configured the codebase parame-
ter in your applet code.

Sending a Video Email
� Many Email Client’s today support Java technology.  Hence it is possible to send a VX30 video embedded 
within a HTML email.  When the client opens up their email the video will play right there inside their email client.  
If the email client does not support Java than a hyperlink link will appear instead.  If the client clicks on that link their 
web browser will launch and the video will play through the browser.  An important aspect of VX30 video email is 
that the video is not sent as an attachment.  When the video email is opened in the email client the java code con-
tained within will initiate a streaming video session with your web server.  This is important because you do not 
want to fill up your client’s mailbox with a large attachment.  In addition if you are sending a high volume of video 
emails you will take the load off of your mail server and place it on your web server where it belongs.  Finally you 
will only pay for bandwidth that is actually used.  If you send a video file to someone who does not receive or view 
the video than you have wasted the bandwidth is transmitting that message. 


 The requirements for sending a video email are very similar to placing a video in your web page.  You will 
need to encode the video and place it on your web server.  Next you will need to create a HTML page that will be the 
email.  Place your video inside the HTML in the same way you placed the video inside your web page.  Make sure 
you copy and paste all of the applet code and that you use the all important codebase parameter9.  Test your HTML 
by viewing it in your web browser.  Once you are satisfied with the look of your HTML and the video is playing 
properly you are ready to send your message.

Using Outlook Express to Send HTML Email


 To configure Outlook express to send HTML email open up your Options window, Tools -> Options. In the 
window that opens click on the Send tab.  In the section Mail Sending Format make sure the radio button titled 
HTML is selected.  Press OK to save your changes and to exit out of this window.  
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Configuring Outlook


 Now create a new mail message.  After filling in the recipients name and the subject line place your cursor 
into the text area and than choose Insert -> Text From File...  In the window that opens up change the drop down 
menu for Files of type: from Text Files(*.txt) to HTML Files (*.htm, *.html).  Than navigate to the location of your 
HTML email and than click Open.  
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Inserting HTML Text Into Your Email
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Glossary
A) Applet

A java applet is a little application.  Prior to the World 
Wide Web, the built-in writing and drawing programs 
that came with Windows were sometimes called 
“applets.” On the Web, using Java, the objected-oriented 
programming language, an applet is a small program 
that can be sent along with a Web page to a user.  Java 
applets can perform interactive animations, immediate 
calculations, or other tasks without having to send a user 
request back to the server. 

B) Bit

A bit is an electronic signal, which is either on (1) or off 
(0).  It is the smallest unit of information the computer 
uses.

C) Byte

A byte is a group of 8 bit, strung together.

D) Codec

Short for compressor/decompressor, a codec is any tech-
nology for compressing and decompressing data.  Co-
decs can be implemented in software, hardware, or a 
combination of both.  Some popular codecs for computer 
video include MPEG, Indeo and Cinepak. 

E) Encoder

A facility that encodes data for the purpose of achieving 
data compression. Frequently, the data to be encoded is 
video data, but other types of data, including audio, can 
be compressed as well. Contrast with decoder. See also 
cell encoding, data compression, entropy coding, H.261 
encoding, hierarchical encoding, predictive encoding, 
run-length encoding, sequential encoding.

F) Jar File

(Java ARchive file.) A file used for aggregating many files 
into one file.

G) Mono

Designating sound transmission or recording or repro-
duction over a single channel.

H) Sample Rate

Sample rate describes how frequently an analog audio 
signal is sampled as it is converted into a series of num-
bers.  44.1 kHz is the standard sample rate for compact 
disks; 48 kHz is often used with digital audio tape (DAT) 
recording.  22.050 kHz is frequently used for games and 
multimedia.  A higher sample rate allows a higher fre-
quency response.  In order to accurately reconstruct a 
sound , the sample rate must be at least twice the highest 
frequency in the sound.

I) Stereo

A method of producing sound where the audio is mixed 
in two different channels.  This is so that the human ears 
can detect direction that the sound is coming from.  Usu-
ally it is used with music to give a fuller, more natural 
sound.  It has two separate audio channels.
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